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LAND ACKNOWLEDGEMENT

Photo by Sue Thompson, CC BY-ND 2.0

The Land Acknowledgement is done to remember and honour those that cared for and lived on the land
1000s of years before it became Canada. The Land Acknowledgement tells the true history of this land we call
Canada, and that it was inhabited by the First Peoples long before Christopher Columbus claimed to discover
it. From the first moment Columbus came to the America’s, violence and colonization occurred and
continues today (Robertson, 2019).

We acknowledge and honour the Anishinaabe, Haudenoshaunee, and Lenape people of

Southwestern Ontario as the traditional owners and custodians of the lands and waterways

where Fanshawe College is located. Further, we acknowledge the cultural diversity of all

Indigenous peoples and pay respect to Elders past, present and future. We celebrate the

continuous living cultures of the original inhabitants of Canada and acknowledge the important

contributions Indigenous people have and continue to make in Canadian society. The College
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respects and acknowledges our Indigenous students, staff, Elders, and Indigenous visitors who

come from many nations.

While land acknowledgements are an important starting point for working towards truth and reconciliation,
it’s essential that we remember that that’s what it is: a starting point. If we do land acknowledgements
without taking serious steps towards understanding the truth of Canada’s shameful history of oppression of
Indigenous peoples (that continues today) and without actively working towards challenging and dismantling
Settler Colonialism, our land acknowledgements become meaningless tokens.
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EQUALITY, DIVERSITY, & INCLUSION

The Centre for Equity, Diversity and Inclusion at Fanshawe

Fanshawe College is committed to fostering a

place where we belong. Of our six EDI

priorities, one speaks to belonging in our

workplaces. As field placement partners, we

invite you to also create a sense of belonging

in your work with us to align with our EDI

priorities. This value alignment is of

paramount importance to ensure a safe,

equitable, and fair space for our students to

feel heard and appreciated in the work that

they do. Fanshawe is committed to fostering

this attitude in our students as well, and the expectation of our students is they will work to

foster this type of environment while on field placement.

How Can We All Create a Place Where We Belong?

Here are seven tips for creating an inclusive and safe workplace:

1. Have safe and confidential spaces to report instances of inequity, discrimination, and harassment.
2. Use pronouns when you introduce yourself and in email signatures.
3. Proactively remove barriers to Equity, Diversity, Inclusion, and Accessibility by doing an EDIA Audit

and link progress to actionable, measurable, and scheduled outcomes.
4. Commit your organization to lifelong unlearning and learning through formal EDI education and

allowing both employees and student placements to informally engage in the community to unlearn and
learn.

5. Offer anti-discrimination and anti-racism training, with particular emphasis on name discrimination
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and how it relates to students from equity-deserving communities.
6. Start meetings with a personal land acknowledgement and give others the opportunity to do so as well.
7. Promote a culture of work-life balance and demonstrate a commitment to the diverse ways that look for

equity-deserving communities.

Resources:

Visit the Equality, Diversity, & Inclusion page to access the links.

• Advancing Justice, Equity, Diversity and Inclusion in Work Integrated Learning [PDF]

• What Works Toolkit

• The Guide to Allyship

• Gender Unicorn
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ABOUT THIS BOOK

The reader will be introduced to the Apprenticeship Pathway to obtaining their early education diploma at
Fanshawe College.

This Open Resource is where you will find everything you need to complete the six placements required,
along with some additional resource material that will support you in your journey to completing your
apprenticeship training.

Accessibility Statement

We are actively committed to increasing the accessibility and usability of the textbooks we

produce. Every attempt has been made to make this OER accessible to all learners and is

compatible with assistive and adaptive technologies. We have attempted to provide closed

captions, alternative text, or multiple formats for on-screen and offline access.

The web version of this resource has been designed to meet Web Content Accessibility

Guidelines 2.0, level AA. In addition, it follows all guidelines in Appendix A: Checklist for

Accessibility of the Accessibility Toolkit – 2nd Edition.

In addition to the web version, additional files are available in a number of file formats, including

PDF, EPUB (for eReaders), and MOBI (for Kindles).

If you are having problems accessing this resource, please contact us at oer@fanshawec.ca.

Please include the following information:

• The location of the problem by providing a web address or page description

• A description of the problem

• The computer, software, browser, and any assistive technology you are using that can

help us diagnose and solve your issue (e.g., Windows 10, Google Chrome (Version

65.0.3325.181), NVDA screen reader)
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Feedback

Please share your adoption and any feedback you have about the book with us at oer@fanshawec.ca
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CHAPTER 1 - GETTING STARTED

Chapter Outline

1.0 Learning Outcomes

1.1 Why take the Child Development Program (CDP) program pathway to your ECE diploma?

1.2 The Steps to Getting Registered in Courses at Fanshawe College

1.3 Placements Throughout the Program
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1.0 LEARNING OUTCOMES

Learning Outcomes

By the end of this chapter, the apprentice will be able to:

• Outline the steps for registering as an ECE apprentice and the placement requirements.

• Describe the pathway to getting their ECE diploma.

Photo by Ian Schneider, Unsplash License.
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1.1 WHY TAKE THE CHILD DEVELOPMENT
PROGRAM (CDP) PROGRAM PATHWAY TO
YOUR ECE DIPLOMA?

You and your employer enter into a contract, representing your employer’s willingness to support you in
gaining specific skills at the workplace as well as the signing-off of your contract, which reflects the number of
working hours you have accrued.

While enrolled at Fanshawe College, the apprentices are also registered as Child Development Practitioner
Apprentices with the Ministry of Trades.

The apprentice completes eighteen courses that run over 7 weeks at Fanshawe College in a hybrid format with
synchronous and asynchronous online classes. Students can take one course or all that are offered each
semester as long as they meet prerequisites and six (6) placements, with most placements being completed
within their current workplace.

Before graduating as an Apprentice, 5280 hours of work, practical experience in child care, and 720
placement hours must be completed and documented.

Documentation for the Ministry of Trades includes maintaining a Log book [PDF].

The First Step

The apprentice is to contact the nearest Ministry office to ask for an “Application for

Apprenticeship,” which can be completed online. The training consultant is chosen based on where

the employer is located. To speak with a representative at the Ministry, please contact

appr.london@ontario.ca.
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1.2 THE STEPS TO GETTING REGISTERED IN
COURSES AT FANSHAWE COLLEGE

The application will be emailed to the apprentice or employer. Academic qualification for the 620C (Trade
Code) is the completion of Grade 12. (In this case below, the apprentice must have presented a copy of their
high school transcript to MTCU in order to qualify for apprenticeship).

• The form is completed and emailed back to the training consultant at the Ministry.

• The training consultant then emails a “Training Agreement” to the employer.

• The apprentice and employer complete and sign the agreement and email it back to the

Training Consultant.

• MTCU creates a record for the apprentice and issues a Client ID number. The date of

signing the agreement is referred to as the “Seniority Date.”

• Within 90 days of signing the training agreement, an apprentice must complete the

application for Membership in the Ontario College of Trades”. The application is sent to

the apprentice from MTCU. The fee currently for that membership is $60 plus HST.

• Once the apprentice is “signed” at the London office, a copy of their application and

agreement is sent to Fanshawe College’s Registrar’s office. Fanshawe will contact you

regarding registration and schedule.

This program is a part-time program, so you can register in one or more courses depending on your personal
circumstances. The typical timeline to complete the program is 3 years.
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Photo by Fanshawe College. ©
All Rights Reserved. Used with
Permission.

All courses and placements costs are much lower than a regular diploma
course. Currently, courses cost $112.19 and Placements cost
$62.47plus taking 3 (three) General Education College Level Courses
(Electives) at Fanshawe College. The General education courses qualify
for the ECE Grant.

In the following few chapters, we will provide all the paperwork and
forms needed to successfully complete the placement portion of the
program.

The model for Apprenticeship placement is that your Curriculum
Professor is your direct faculty support. This means the student takes the
Curriculum and Placement courses at the same time.

You are NOT assigned a faculty advisor, as the assumption is most of your
hours are done within your workplace or workplace organization. Your
placement hours are to be completed within the 7-week time
period you are registered, with all paperwork to be completed by
the last day of the term.
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1.3 PLACEMENTS THROUGHOUT THE
PROGRAM

The following six placements will be completed throughout your training program:

Foundations of Early Learning

This placement occurs in a Ministry of Education-approved program (such as Child Care, Ontario Early
Years, Kindergarten, Parent and Family Literacy Centres). Licensed school-age programs do not qualify for
this placement.

Chapter 4 – FLDP 1030- Foundations of Early Learning Placement

Pre-school Learning Environment 1

This placement occurs in a Ministry of Education-approved program for children ages 2.5 to 6 years old (such
as Child Care, Ontario Early Years, Kindergarten, Parent and Family Literacy Centres).

Chapter 5- FLDP 3033-Pre-school Learning Environment I

Pre-school Learning Environment 2

This placement occurs in a Ministry of Education-approved program for children ages 2.5 to 6 years old (such
as Child Care, Ontario Early Years, Kindergarten, Parent and Family Literacy Centres).

Chapter 6 – FLDP-5011 Pre-school Learning Environment 2

School-age Learning Environment
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This placement occurs in a Ministry of Education-approved program for children ages 6 to 12 years old.
School-age children are those in grade 1 and up, until the age of 12 (such as licensed school-age programs).

Chapter 7 – FLDP 3034 School Age Learning Environment

Infant and Toddler Learning Environment

This placement occurs in a Ministry of Education-approved program for children ages 0 to 30 months (such
as licensed infant and toddler programs). Ontario Early Years programs that are geared towards infant and
toddler participants are acceptable.

Chapter 8 – FLDP 5010 Infant Toddler Learning Environment

Advanced Placement

This placement occurs in a Ministry of Education-approved program (such as Child care, Ontario Early Years,
Kindergarten, Parent and Family Literacy Centres). Licensed school-aged programs do not qualify for this
placement.

Chapter 9 – FLDP 5012 Advanced Placement

Additional Resources

Visit page 1.3 Placements Throughout the Program to access these links

• Child Development Practitioner – Skilled Trades Ontario

• Child Development Practitioner [Apprenticeship] | Fanshawe College
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Apprenticeship Curriculum Standard Child Development Practitioner by Ontario College of Trades from
Skilled Trades Ontario. Used under Fair Dealing for Educational Purposes (Canada).
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CHAPTER 2 - FIELD PLACEMENT
ROLES AND RESPONSIBILITIES

Chapter Outline

2.0 Learning Outcome

2.1 Apprentice Responsibilities

2.2 Agency Mentor’s Responsibility

2.3 Fanshawe College Faculty Responsibilities

2.4 CDP Tracking Form
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2.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Describe their roles and responsibilities as well as those of their agency mentor and college

faculty.

“RECEs build positive relationships with colleagues by

demonstrating respect, trust, and integrity. They support,

mentor and collaborate with colleagues, including students

aspiring to the profession” (CECE, 2017, p7).
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Licence.

Important Note

The model for Apprenticeship placement is that

your Curriculum Professor is your direct faculty

support. This means the student takes the

Curriculum and Placement courses at the same

time.

You are NOT assigned a faculty advisor, as the

assumption is most of your hours are done

within your workplace or workplace

organization. Your placement hours are to be

completed within the 7-week period you are

registered, with ALL paperwork to be

completed by the last day of the term.
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2.1 APPRENTICE'S RESPONSIBILITIES

• Review the Field Placement Workbook with your Agency Mentor
• Give the Progress Record to your Mentor to complete

Getting Started

• Record daily placement hours using Record of Attendance Form (this varies depending on which
placement you are completing)

Attendance

• Review the assigned curriculum requirements for the placement with your Agency Mentor
• Complete any related documentation & share it with your Agency Mentor
• Plan with your Agency Mentor other ways you can contribute to the daily curriculum

Curriculum Planning & Implementation

• Complete the ‘Self-Reflection’
• Meet with the Practicum Mentor to review your evaluations
• Provide a copy of your ‘Self-Reflection’ to your Mentor
• Prepare a signed copy of your evaluation to submit to the FOL submission folder in the

corresponding curriculum course. The Apprentice will ensure all paperwork has the necessary
signatures, which may be verified by your Curriculum Professor.

Evaluation
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“Relationship Between ECE Partners”, Sanaz Habibi, CC BY-NC-SA 4.0

Image Description

The image depicts a triangular relationship between three entities: an “Apprentice,” an “ECE Agency
Mentor,” and a “Fanshawe College Faculty Advisor.” At the centre of the triangle is a large circle containing
various action words that describe the nature of interactions and roles shared among the three entities. The
words in the central circle are Collaborate, Guide, Mentor, Encourage, Lead, Connect, Communicate,
Observe, Respect, Share, and Support.

The “Apprentice” is at the top of the diagram, with the “ECE Agency Mentor” positioned at the bottom left
and the “Fanshawe College Faculty Advisor” on the bottom right.
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Arrows between the central circle and the three entities suggest mutual engagement and communication
focused on guiding and supporting the student’s development. This image illustrates mentors’ and advisors’
collaborative and supportive roles in helping the Apprentice thrive.
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2.2 AGENCY MENTOR'S RESPONSIBILITY

The practicum mentor must be a registered member of the College of Early Childhood Educators.

To support apprentices, we encourage you to:

Be a mentor to your apprentice, offering encouragement and support for their learning, asking and
answering questions, and offering feedback regarding the apprentice’s achievements and successes. Offer
suggestions and guidance for the development of new skills. See Chapter 3 – Mentoring Relationships
for more information on the topic of Mentoring.

Be a Mentor

Use the Progress Record provided to document your apprentice’s learning. Discuss your observations
with the apprentice.

See chapters 5-10 for individual placement requirements and forms

Record Progress

On an ongoing basis, discuss with your apprentice the relationship between theory and their
Pedagogical Practice [PDF].

Pedagogical Discussion

Review and sign all placement forms once the apprentice has completed their hours.

Review and Sign
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2.3 FANSHAWE COLLEGE FACULTY'S
RESPONSIBILITIES

Deliver the Curriculum Course that is a co-requisite to the Field Placement.

Deliver

Review the Placement requirements in that course and answer any questions related to the apprentice’s
responsibilities.

Review

Ensure all paperwork is submitted and grades assigned within the given time frame.

Ensure
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2.4 CDP TRACKING FORM

Visit 2.4 CDP Tracking Form to access the link

Use this form to track your progress through the program:

Child Development Practitioner/ Early Childhood Education (CDP/ECE4) Progression Tracking

Form [PDF]
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CHAPTER 3 - MENTORING
RELATIONSHIPS

Chapter Outline

3.0 Learning Outcome

3.1 The Mentoring Relationship

3.2 Additional Resources
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3.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the agency mentors, apprentices, and faculty will:

• Engage with mentoring practices as part of their practicum experience.

“Word cloud”, by Sheryl Third, CC BY-NC-SA 4.0
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To begin, let us look at how our regulatory body, the College of Early Childhood Educators, defines
Mentoring:

“A reciprocal, relationship-based and process-oriented professional learning experience between two
individuals (a mentor and a mentee) in the early learning and care sector. The purpose of the relationship is to
learn and improve professional practice through reflective practice, self-directed learning, and
collaboration”. A Mentor is an individual who shares and uses their knowledge, skills, and experiences to
support and guide a mentee to improve their practice and acquire new skills” (College of Early Childhood
Educators, 2018, p.2).

The delicate balance of mentoring someone is not creating

them in your own image but giving them the opportunity to

create themselves

—Steven Spielberg
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3.1 THE MENTORING RELATIONSHIP

Activity

Watch the videos below to provoke conversation about what traits or dispositions are necessary to

be a mentor and what a positive mentor relationship looks like in your day-to-day work as an

early-years professional.

What are the main messages in the videos that resonate with you as you consider mentoring and

your mentoring relationship?

Now Consider Your Disposition:

1. Demonstrate enthusiasm for learning and seek multiple perspectives.

2. Exemplify positive professional ethics and behaviours.

3. Have a positive attitude that expresses wonder and awe towards my work.

4. Devote the time needed to develop positive and effective relationships.

5. Encourage, motivate, and empower others to achieve their professional goals.

6. Find joy and passion in my day-to-day routines and work.

If you answered Yes to most of the above dispositions, you are ready to mentor an ECE Student.
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(Zachary, 2012).
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3.2 ADDITIONAL RESOURCES

If you wish to explore the topic of Mentoring, here are some additional resources:

Visit page 3.2 Additional Resources, to access the link to this resource.

• Mentoring: In Search of Meaning — Strive

• The College of Early Childhood Education also has a Resource on Mentoring [PDF]
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CHAPTER 4 - FLDP 1030-
FOUNDATIONS OF EARLY
LEARNING PLACEMENT

Chapter Outline

4.0 Learning Outcome

4.1 Workbook for Submission – Foundations of Early Learning

4.2 Practicum Resources
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4.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Apply current and accessible resources to the field placement experiences and document the

completion of the placement outcomes.

Placement Details

Foundations of Early Learning (42 hours): This
placement occurs in a Ministry of Education-approved
program (such as Child care, Ontario Early Years,
Kindergarten, Parent and Family Literacy Centres).
Licensed school-age programs do not qualify for this
placement.

“Play is the highest expression of human development in

childhood, for it alone is the free expression of what is in a

child’s soul.” ― Friedrich Froebel
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Placement details: Apprenticeship Curriculum Standard Child Development Practitioner by Ontario College
of Trades from Skilled Trades Ontario. Used under Fair Dealing for Educational Purposes (Canada).
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4.1 WORKBOOK FOR SUBMISSION -
FOUNDATIONS OF EARLY LEARNING

Access your Workbook for the Foundations of Early
Learning Practicum by visiting page 4.1 Workbook for
Submission in the Fanshawe College Child Development
Practicum Hub

Workbook Guides

Make a Copy of the Practicum Workbook

To create your version of the Practicum Workbook, click on the link found in the OER (above).

If you are not already, signed into Google, you will be prompted to sign in.
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Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click
Make a copy.

You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and
place your name. When you click away, it will be saved.

Share Your Practicum Workbook

Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if
applicable.

To share your workbook, follow these steps.

Click on the Share button.
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Under General access, change from “Restricted” to “Anyone with the link”.

Then click on “Viewer” and change it to “Editor”.
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Click the Copy link button.
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Now your link is copied you can email it to others who need access to the document.

Completing and Signing the Practicum Workbook

The workbook contains several different types of fillable areas. While many areas are for the student or
apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor.

Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin
typing.
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You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the
top of the page.

There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to
uncheck a box, click it again.

Text areas and checkboxes can also be mixed together and can be completed as outlined.
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In some areas, you will see a Date button.

Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
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In some areas, you might be asked for a signature. You can draw your signature through the following steps.

Place your cursor (click) in the signature box.

Click on the Insert menu, choose Drawing, and then New.
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From the Line menu, choose Scribble.

Draw your signature in the box, and then click Save and Close.
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Grab the corner of the box and drag it to resize the drawing.

Downloading Your Practicum Workbook

When it is time to submit your completed workbook to FOL you can download a copy. To download the
workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
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You can then upload this document into the Submission Folder in FanshaweOnline.

To access more information about using Google Docs, such as making an account, visit Appendix A: Google
Skills.
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4.2 PRACTICUM RESOURCES

This is not an exhaustive list of resources, but some that may support your placement experience.

Additional Resources

Visit 4.2 Practicum Resources to view the links.

• Excerpts from Early Learning for Every Child Today [PDF]

• How Does Learning Happen: Ontario’s Pedagogy for Early Years

• Building on How Does Learning Happen Child Care [PDF]

• Indigenous Early Learning and Child Care Framework

• Canadian Centre for Outdoor Play » Outdoor Play Canada

• Self-Regulation in Early Childhood – Self-Reg
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CHAPTER 5 - FLDP
3033-PRE-SCHOOL LEARNING
ENVIRONMENT I

Chapter Outline

5.0 Learning Outcome

5.1 Workbook for Submission

5.2 Practicum Resources
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Photo by Alexandr Podvalny, Unsplash License.

5.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Apply current and accessible resources to the field placement experiences and document the

completion of placement outcomes.

Placement Details

Pre-school Learning Environment I (72 hours): This
placement occurs in a Ministry of Education-approved
program for children ages 2.5 to 6 (such as Child care,
Ontario Early Years, Kindergarten, Parent and Family
Literacy Centres).

“The world is full of magic things, patiently waiting for our

senses to grow sharper.” ― W.B. Yeats
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Placement Details: Apprenticeship Curriculum Standard Child Development Practitioner by Ontario
College of Trades from Skilled Trades Ontario. Used under Fair Dealing for Educational Purposes (Canada).
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5.1 WORKBOOK FOR SUBMISSION -
PRESCHOOL LEARNING ENVIRONMENT 1

Access your Workbook for the Pre-school Learning
Environment I Practicum on page 5.1 Workbook for
Submission – Preschool Learning Environment 1 in the
OER Fanshawe College Child Development Practitioner
Practicum Hub

Workbook Guides

Make a Copy of the Practicum Workbook

To create your version of the Practicum Workbook, click on the link found in the OER (above).

If you are not already, signed into Google, you will be prompted to sign in.
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Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click
Make a copy.

You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and
place your name. When you click away, it will be saved.

Share Your Practicum Workbook

Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if
applicable.

To share your workbook, follow these steps.

Click on the Share button.
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Under General access, change from “Restricted” to “Anyone with the link”.

Then click on “Viewer” and change it to “Editor”.
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Click the Copy link button.
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Now your link is copied you can email it to others who need access to the document.

Completing and Signing the Practicum Workbook

The workbook contains several different types of fillable areas. While many areas are for the student or
apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor.

Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin
typing.
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You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the
top of the page.

There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to
uncheck a box, click it again.

Text areas and checkboxes can also be mixed together and can be completed as outlined.
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In some areas, you will see a Date button.

Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
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In some areas, you might be asked for a signature. You can draw your signature through the following steps.

Place your cursor (click) in the signature box.

Click on the Insert menu, choose Drawing, and then New.
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From the Line menu, choose Scribble.

Draw your signature in the box, and then click Save and Close.

50 | 5.1 WORKBOOK FOR SUBMISSION - PRESCHOOL LEARNING ENVIRONMENT 1



Grab the corner of the box and drag it to resize the drawing.

Downloading Your Practicum Workbook

When it is time to submit your completed workbook to FOL you can download a copy. To download the
workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
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You can then upload this document into the Submission Folder in FanshaweOnline.

To access more information about using Google Docs, such as making an account, visit Appendix A: Google
Skills.
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5.2 PRACTICUM RESOURCES

Additional Resources

Visit 5.2 Practicum Resources to access links.

• Excerpts from Early Learning for Every Child Today [PDF]

• How Does Learning Happen: Ontario’s Pedagogy for Early Years

• Building on How Does Learning Happen Child Care [PDF]

• Indigenous Early Learning and Child Care Framework

• Canadian Centre for Outdoor Play » Outdoor Play Canada

• Self-Regulation in Early Childhood – Self-Reg
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CHAPTER 6 - FLDP-5011
PRE-SCHOOL LEARNING
ENVIRONMENT 2

Chapter Outline

6.0 Learning Outcome

6.1 Workbook for Submission

6.2 Practicum Resources
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6.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Apply current and accessible resources to the field placement experiences and document the

completion of placement outcomes.

“Let us take care of the children…for they have a long way

to go. Let us take care of the elders…for they have come a long

way. Let us take care of the in-betweens…for they are doing

the work.”

― Indigenous saying
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Placement Details

Pre-school Learning Environment 2 PLacement: This
placement is 78 hours and occurs in a Ministry of
Education-approved program for children ages 2.5 to 6
(such as Child care, Ontario Early Years, Kindergarten,
Parent and Family Literacy Centres).

Placement Details: Apprenticeship Curriculum Standard Child Development Practitioner by Ontario
College of Trades from Skilled Trades Ontario. Used under Fair Dealing for Educational Purposes (Canada).
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6.1 WORKBOOK FOR SUBMISSION -
PRE-SCHOOL LEARNING ENVIRONMENT 2

Visit 6.1 Workbook for Submission Pre-school Learning
Environment 2 Workbook to access your Workbook

Workbook Guides

Make a Copy of the Practicum Workbook

To create your version of the Practicum Workbook, click on the link found in the OER (above).

If you are not already, signed into Google, you will be prompted to sign in.
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Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click
Make a copy.

You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and
place your name. When you click away, it will be saved.

Share Your Practicum Workbook

Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if
applicable.

To share your workbook, follow these steps.

Click on the Share button.
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Under General access, change from “Restricted” to “Anyone with the link”.

Then click on “Viewer” and change it to “Editor”.
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Click the Copy link button.
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Now your link is copied you can email it to others who need access to the document.

Completing and Signing the Practicum Workbook

The workbook contains several different types of fillable areas. While many areas are for the student or
apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor.

Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin
typing.
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You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the
top of the page.

There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to
uncheck a box, click it again.

Text areas and checkboxes can also be mixed together and can be completed as outlined.
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In some areas, you will see a Date button.

Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
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In some areas, you might be asked for a signature. You can draw your signature through the following steps.

Place your cursor (click) in the signature box.

Click on the Insert menu, choose Drawing, and then New.
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From the Line menu, choose Scribble.

Draw your signature in the box, and then click Save and Close.
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Grab the corner of the box and drag it to resize the drawing.

Downloading Your Practicum Workbook

When it is time to submit your completed workbook to FOL you can download a copy. To download the
workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
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You can then upload this document into the Submission Folder in FanshaweOnline.

To access more information about using Google Docs, such as making an account, visit Appendix A: Google
Skills.
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6.2 PRACTICUM RESOURCES

Visit 6.2 Practicum Resources to access the links.

Additional Resources

• Excerpts from Early Learning for Every Child Today [PDF]

• How Does Learning Happen: Ontario’s Pedagogy for Early Years

• Building on How Does Learning Happen Child Care [PDF]

• Indigenous Early Learning and Child Care Framework

• Canadian Centre for Outdoor Play » Outdoor Play Canada

• Self-Regulation in Early Childhood – Self-Reg
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CHAPTER 7 - FLDP 3034 SCHOOL
AGE LEARNING ENVIRONMENT

Chapter Outline

7.0 Learning Outcome

7.1 Workbook for Submission

7.2 Practicum Resources
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7.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Apply current and accessible resources to the field placement experiences and document the

completion of placement outcomes.

“Through play and inquiry, young children practice ways of

learning and interacting with the world around them that they

will apply throughout their lives.”

― How Does Learning Happen: Ontario’s Pedagogy for Early

Years
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Placement Details

FLDP 3034 School Age Learning Environment
Placement: This placement is 39 hours and occurs in a
Ministry of Education-approved program for children
ages 6 to 12. School-age children are those in grade 1 and
up until 12 (such as licensed school-age programs).

Placement Details: Apprenticeship Curriculum Standard Child Development Practitioner by Ontario
College of Trades from Skilled Trades Ontario. Used under Fair Dealing for Educational Purposes (Canada).
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7.1 WORKBOOK FOR SUBMISSION -
SCHOOL AGE LEARNING ENVIRONMENT

Access the FLDP 3034 Workbook here on page 7.1
Workbook for School Age Learning Environment of the in
the OER Fanshawe College Child Development
Practitioner Practicum Hub

Workbook Guides

Make a Copy of the Practicum Workbook

To create your version of the Practicum Workbook, click on the link found in the OER (above).

If you are not already, signed into Google, you will be prompted to sign in.
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Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click
Make a copy.

You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and
place your name. When you click away, it will be saved.

Share Your Practicum Workbook

Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if
applicable.

To share your workbook, follow these steps.

Click on the Share button.

7.1 WORKBOOK FOR SUBMISSION - SCHOOL AGE LEARNING ENVIRONMENT | 73



Under General access, change from “Restricted” to “Anyone with the link”.

Then click on “Viewer” and change it to “Editor”.
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Click the Copy link button.
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Now your link is copied you can email it to others who need access to the document.

Completing and Signing the Practicum Workbook

The workbook contains several different types of fillable areas. While many areas are for the student or
apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor.

Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin
typing.
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You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the
top of the page.

There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to
uncheck a box, click it again.

Text areas and checkboxes can also be mixed together and can be completed as outlined.
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In some areas, you will see a Date button.

Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
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In some areas, you might be asked for a signature. You can draw your signature through the following steps.

Place your cursor (click) in the signature box.

Click on the Insert menu, choose Drawing, and then New.
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From the Line menu, choose Scribble.

Draw your signature in the box, and then click Save and Close.
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Grab the corner of the box and drag it to resize the drawing.

Downloading Your Practicum Workbook

When it is time to submit your completed workbook to FOL you can download a copy. To download the
workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
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You can then upload this document into the Submission Folder in FanshaweOnline.

To access more information about using Google Docs, such as making an account, visit Appendix A: Google
Skills.
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7.2 PRACTICUM RESOURCES

Additional Resources

Visit 7.2 Practicum Resources to access links.

• Excerpts from Early Learning for Every Child Today [PDF]

• How Does Learning Happen: Ontario’s Pedagogy for Early Years

• Building on How Does Learning Happen Child Care [PDF]

• Indigenous Early Learning and Child Care Framework

• Canadian Centre for Outdoor Play » Outdoor Play Canada

• Self-Regulation in Early Childhood – Self-Reg
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CHAPTER 8 - FLDP 5010 INFANT
TODDLER LEARNING
ENVIRONMENT

Chapter Outline

8.0 Learning Outcome

8.1 Workbook for Submission

8.2 Practicum Resources
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8.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Apply current and accessible resources to the field placement experiences and document the

completion of the placement outcomes

Placement Details

FLDP 5010-Infant Toddler Placement: This placement is
54 hours and occurs in a Ministry of Education-approved
program for children ages 0 to 30 months (such as
licensed infant and toddler programs). Ontario Early
Years programs geared towards infant and toddler
participants are acceptable.

“It takes a village to raise a child” – African Proverb
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Placement Details: Apprenticeship Curriculum Standard Child Development Practitioner by Ontario
College of Trades from Skilled Trades Ontario. Used under Fair Dealing for Educational Purposes (Canada).
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8.1 WORKBOOK FOR SUBMISSION - INFANT
AND TODDLER LEARNING

Access the FLDP 5010 Workbook here on page 8.1
Workbook for Submission – Infant and Toddler Learning
of the in the OER Fanshawe College Child Development
Practitioner Practicum Hub

Workbook Guides

Make a Copy of the Practicum Workbook

To create your version of the Practicum Workbook, click on the link found in the OER (above).

If you are not already, signed into Google, you will be prompted to sign in.
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Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click
Make a copy.

You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and
place your name. When you click away, it will be saved.

Share Your Practicum Workbook

Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if
applicable.

To share your workbook, follow these steps.

Click on the Share button.
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Under General access, change from “Restricted” to “Anyone with the link”.

Then click on “Viewer” and change it to “Editor”.
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Click the Copy link button.
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Now your link is copied you can email it to others who need access to the document.

Completing and Signing the Practicum Workbook

The workbook contains several different types of fillable areas. While many areas are for the student or
apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor.

Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin
typing.
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You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the
top of the page.

There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to
uncheck a box, click it again.

Text areas and checkboxes can also be mixed together and can be completed as outlined.
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In some areas, you will see a Date button.

Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
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In some areas, you might be asked for a signature. You can draw your signature through the following steps.

Place your cursor (click) in the signature box.

Click on the Insert menu, choose Drawing, and then New.
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From the Line menu, choose Scribble.

Draw your signature in the box, and then click Save and Close.
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Grab the corner of the box and drag it to resize the drawing.

Downloading Your Practicum Workbook

When it is time to submit your completed workbook to FOL you can download a copy. To download the
workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
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You can then upload this document into the Submission Folder in FanshaweOnline.

To access more information about using Google Docs, such as making an account, visit Appendix A: Google
Skills.
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8.2 PRACTICUM RESOURCES

View page 8.2 Practicum Resources to access links.

Additional Resources

• Excerpts from Early Learning for Every Child Today [PDF]

• How Does Learning Happen: Ontario’s Pedagogy for Early Years

• Building on How Does Learning Happen Child Care [PDF]

• Indigenous Early Learning and Child Care Framework

• Canadian Centre for Outdoor Play » Outdoor Play Canada

• Self-Regulation in Early Childhood – Self-Reg
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CHAPTER 9 - FLDP 5012 ADVANCE
PLACEMENT

Chapter Outline

9.0 Learning Outcome

9.1 Workbook for Submission

9.2 Practicum Resources
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9.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Apply current and accessible resources to the field placement experiences and document the

completion of placement outcomes.

Placement Details

FLDP 5012-Advanced Placement: This placement is 96
hours and takes place in an inclusive setting, working
with children with special needs. It can be a family centre
plus any of the previous settings, except it cannot be
done in Before and After School-Age programs,
including Kindergarten Before and After programs.

A child’s world is fresh and new and beautiful, full of wonder

and excitement. It is our misfortune that for most of us, that

clear-eyes awe-inspiring instinct is dimmed or even lost before

we reach adulthood”. – Rachel Carson (1998, p.44)
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Placement Details: Apprenticeship Curriculum Standard Child Development Practitioner by Ontario
College of Trades from Skilled Trades Ontario. Used under Fair Dealing for Educational Purposes (Canada).
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9.1 WORKBOOK FOR SUBMISSION -
ADVANCED PLACEMENT

Access the FLDP 3034 Workbook here on page 9.1
Workbook for Submission – Advanced Placement of the in
the OER Fanshawe College Child Development
Practitioner Practicum Hub

Workbook Guides

Make a Copy of the Practicum Workbook

To create your version of the Practicum Workbook, click on the link found in the OER (above).

If you are not already, signed into Google, you will be prompted to sign in.

102 | 9.1 WORKBOOK FOR SUBMISSION - ADVANCED PLACEMENT



Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click
Make a copy.

You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and
place your name. When you click away, it will be saved.

Share Your Practicum Workbook

Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if
applicable.

To share your workbook, follow these steps.

Click on the Share button.
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Under General access, change from “Restricted” to “Anyone with the link”.

Then click on “Viewer” and change it to “Editor”.

104 | 9.1 WORKBOOK FOR SUBMISSION - ADVANCED PLACEMENT



Click the Copy link button.
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Now your link is copied you can email it to others who need access to the document.

Completing and Signing the Practicum Workbook

The workbook contains several different types of fillable areas. While many areas are for the student or
apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor.

Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin
typing.
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You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the
top of the page.

There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to
uncheck a box, click it again.

Text areas and checkboxes can also be mixed together and can be completed as outlined.
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In some areas, you will see a Date button.

Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
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In some areas, you might be asked for a signature. You can draw your signature through the following steps.

Place your cursor (click) in the signature box.

Click on the Insert menu, choose Drawing, and then New.

9.1 WORKBOOK FOR SUBMISSION - ADVANCED PLACEMENT | 109



From the Line menu, choose Scribble.

Draw your signature in the box, and then click Save and Close.
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Grab the corner of the box and drag it to resize the drawing.

Downloading Your Practicum Workbook

When it is time to submit your completed workbook to FOL you can download a copy. To download the
workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
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You can then upload this document into the Submission Folder in FanshaweOnline.

To access more information about using Google Docs, such as making an account, visit Appendix A: Google
Skills.
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9.2 PRACTICUM RESOURCES

Visit 9.2 Practicum Resources to access links.

Additional Resources

• Excerpts from Early Learning for Every Child Today [PDF]

• How Does Learning Happen: Ontario’s Pedagogy for Early Years

• Building on How Does Learning Happen Child Care [PDF]

• Indigenous Early Learning and Child Care Framework

• Canadian Centre for Outdoor Play » Outdoor Play Canada

• Self-Regulation in Early Childhood – Self-Reg
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CHAPTER 10 - THE COLLEGE OF
EARLY CHILDHOOD EDUCATION
(CECE) - OUR PROFESSIONAL
REGULATORY BODY

Chapter Outline

10.0 Learning Outcome

10.1 What is the College of ECE

10.2 Becoming a College of ECE Member
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10.0 LEARNING OUTCOME

Learning Outcome

By the end of this chapter, the apprentice will be able to:

• Explain the requirements and process for joining the Ontario’s professional regulatory body

once they have completed their ECE diploma.
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10.1 WHAT IS THE COLLEGE OF ECE

The College of Early Childhood Educators (CECE)
regulates and governs Ontario’s Registered Early
Childhood Educators (RECEs) in the public interest.

The College was established under the Early Childhood
Educators Act, 2007 (ECE Act) and came into existence
in February 2009 (College of Early Childhood Educators,
n.d.).

As of 2024, there are more than 57,000 members in good
standing; the College is one of the largest professional
self-regulatory bodies in Ontario and is the only
professional self-regulatory body for early childhood education in Canada (College of Early Childhood
Educators, n.d.).

The College regulates the profession of early childhood education by establishing and enforcing:

• Registration requirements;
• Ethical and professional standards for RECEs;
• Requirements for continuous professional learning; and
• Complaints and discipline process for professional misconduct, incompetence, and incapacity.

(College of Early Childhood Educators, n.d.)
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10.2 BECOMING A COLLEGE OF ECE
MEMBER

Once you have completed the bridge to diploma and have your ECE diploma, you now must
register with the College of Early Childhood Education (CECE) in order to work as an early
years professional in the Province of Ontario.

Once you have completed the Apprenticeship portion and then the bridge to diploma, you are required
to submit an Intent to Graduate form (scroll down to the bottom of the page).

First Step

The CECE has a new member section on their website that includes a webinar to walk you through the
registration process.

New Member Resources | Welcome to the College of Early Childhood Educators

Second Step

Once your paperwork is processed with the Registrar’s office, usually within 10 business days, you will
request an electronic transcript from MYCREDS to go directly to the CECE. Before requesting your
transcript, check on Webadvisor to see if your transcript shows “graduated”.

Third Step
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GLOSSARY

Administrative Leadership

A role in which individuals create a positive organizational climate, ensure legal and financial competence,
engage the community, advocate, foster innovation, and use data to inform strategic planning (Talan et al.,
2023).

AECEO

Association of Early Childhood Educators Ontario.

Agency Mentor

An RECE or leader in an agency that is supporting and guiding the student.

AKB

All Kids Belong.

CCEYA

Childcare and Early Years Act.

CECE
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College of Early Childhood Educators.

Child-centred Curriculum

Is planned and implemented with children’s interests, needs, capacities, and strengths at the heart of the
planning process (Community Child Care, 2011).

COP

Communities of Practice is a group of educators who come together regularly to share and reflect on
different topics.

Curriculum

A learning plan that summarizes what educators’ want children to learn, how they want them to learn it,
and how they plan to teach and assess it (Brightwheel, 2024).

Early Years Agency

Business or Centre in the Early Years System.

ECEA

Early Childhood Educators Act.

Emergent Curriculum

A child-centred approach to education that evolves based on the interests, ideas, and experiences of the
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children, allowing their natural curiosity to guide the learning process (Bright Horizons, 2020).

Field Placement

Refers to the specific assigned location/organization that a student practices within.

Field Practicum

A supervised, hands-on learning experience where students have the opportunity to work directly with
colleagues, children, and families within an early years agency and apply their theoretical knowledge to
real-world situations.

LCCN

Licensed Child Care Network.

Pedagogy

Defined as the understanding of how learning happens- the philosophy, method, and practice of
facilitating learning.
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Pedagogical Leadership

A role in which individuals guide and support educators to enhance teaching and learning practices
through a foundation in research, child development, family engagement, and trauma-informed principles
(Talan et al., 2023).

Pedagogical Practices

The methods, approaches, and strategies used to facilitate learning (ProctorEdu, n.d.).

Play-Based Learning

Learning through play. There are two types of play: Free Play, which is child-directed and motivated, and
Guided Play, which involves the educator offering extended learning opportunities to the play.

Professional Development

This refers to learning opportunities such as workshops or research sessions that support and enhance
professional practices.

Quality

A high level of standard that educators and early years agencies should strive for. Example: A nurturing
environment that supports the social, emotional, and cognitive aspects of child development.

RECE

An Early Childhood Educator who is registered in the field.
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APPENDIX A: GOOGLE SKILLS

Throughout this book, there will be documents to complete as part of your Apprenticeship Workbook.
These documents will require you to complete work in Google Docs. Below, you will find instructions to
help you navigate through the skills needed when using the Google platform.

Creating a Google Account

In order to access the Apprenticeship Workbook documents, you will need a Google account.

If you don’t already have a Google account, you can follow these directions to create one: Creating a Google
Account.

You can find more information about Google, the privacy policy, and how to unlock your account here:
Google Account Tutorial

Using Google Docs

When you click on a Workbook link, you will be asked to make a copy of the document. If you are not signed
in, you will be prompted to do so before you can make a copy.

The copy of this document will be saved in your Google Drive.

You can learn to manage your files in your Google Drive here:

Managing Your Files (instructions)

Managing Your Files (video)

It is a good idea to rename your document with your name and the Workbook page title to keep things
organized. You can see how to rename a document by reading the section To Create a New File on the page
Creating New Files. Note: The file will not say “Untitled Document” but “Copy of Workbook page”.
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Sharing a Google Doc

In order for your faculty advisor and agency mentor to collaborate on the Workbook with you, you will need
to share your document with them.

You can see instructions on how to share your document here:

Sharing and Collaboration (instructions)

Sharing and Collaboration (video)

Downloading a Google Doc

You will be required to upload your document into FOL. To do so, you will need to download a Microsoft
Word copy of your Workbook document so you can upload it into the submissions folder.

To see instructions on how to download your document as a Microsoft Word file see:

Downloading and Printing from Google Drive

124 | APPENDIX A: GOOGLE SKILLS



REFERENCES

Brightwheel. (2024, April 23). An educator’s guide to early childhood curriculum design.
https://mybrightwheel.com/blog/early-childhood-
curriculum#:~:text=A%20curriculum%20in%20early%20childhood,to%20teach%20and%20assess%20lear
ning

Bright Horizons. (2020, February 1). What is emergent curriculum & how it works.
https://www.brighthorizons.com/resources/Article/emergent-curriculum-early-education-approach

Carson, R. (1998). The sense of wonder: A celebration of nature for parents and children. HarperCollins.

College of Early Childhood Educators. (2018, August). Mentoring. Continuous Professional Learning.
https://www.college-ece.ca/en/Documents/CPL%20Resource-Mentoring.pdf

College of Early Childhood Educators (CECE). (2017, July). Code of Ethics and Standards of Practice: For
registered early childhood educators in Ontario. https://www.college-ece.ca/wp-content/uploads/2021/
10/Code_and_Standards_2017-4.pdf

College of Early Childhood Educators. (n.d.). Purpose and mandate. https://www.college-ece.ca/about-us/
purpose-and-mandate/

Community Child Care. (2011). Child-centred curriculum planning (0-5 years): Self-guided learning
package. Inclusion & Professional Support Program. https://www.acecqa.gov.au/sites/default/files/
2021-01/
ChildCentredCurriculumPlanning%20%E2%80%93%200%E2%80%935%20years.PDF#:~:text=A%20chil
d%2Dcentred%20curriculum%3A,for%20children%27s%20needs%2C%20interests%2C%20abilities

ProctorEdu. (n.d.). Pedagogical practice – definition & meaning. https://proctoredu.com/glossary/
pedagogical-practice

Robertson, B. (2019, May 5). Indigenous ways of knowing: The early learning perspective. Association of Early
Childhood Educators of Alberta (AECEA).

Talan, T., Masterson, M., & Bella, J. (2023, April 4). Whole leadership: A framework for early childhood

REFERENCES | 125



programs – 2023. McCormick Center for Early Childhood Leadership. https://mccormickcenter.nl.edu/
library/whole-leadership-a-framework-for-early-childhood-programs-2023/

Zachary, L. (2012). The mentor’s guide: Facilitating effective learning relationships. Jossey-Bass.

126 | REFERENCES



VERSION HISTORY

This page provides a record of edits and changes made to this book since its initial publication. Whenever
edits or updates are made in the text, we provide a record and description of those changes here. If the change
is minor, the version number increases by 0.1. If the edits involve a number of changes, the version number
increases to the next full number.

The files posted alongside this book always reflect the most recent version.

Version Date Change Affected Web Page

1.0 19, December 2024 First Publication N/A
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